MTG

MIDI Patch Changer
User Guide

V4.00
January 2019
Subject to change without notice

CONTENTS
1: Introduction................................................................................................................................ 4
Understanding the Keypad ..................................................................................................... 5
Hooking Up ............................................................................................................................. 6
2: Manual Mode .............................................................................................................................. 8
MIDI Channel .......................................................................................................................... 8
Enable/Disable Banks Select(s) ............................................................................................. 9
To Change a Bank Value Without Sending ............................................................................ 9
To Change a Bank Value With Sending ................................................................................. 9
To Send the Bank and Patch Values .................................................................................... 10
Scrolling through Patches ..................................................................................................... 10
Using the Arrow Key on a Bank Select ................................................................................. 10
3: Preset Mode ............................................................................................................................. 11
Changing Presets By Number .............................................................................................. 12
The MIDI Channel Key.......................................................................................................... 12
Arbitrary MIDI Data ............................................................................................................... 12
4: Editing Presets (on the keypad)............................................................................................. 13
Modifying the Preset ............................................................................................................. 13
Editing the Preset Name ....................................................................................................... 14
Pre/Post-Patch Arbitrary MIDI Data ...................................................................................... 15
Saving ................................................................................................................................... 15
Abandon Changes ................................................................................................................ 15
5: Using Speed Dials ................................................................................................................... 16
Preset Mode Speed Dials ..................................................................................................... 16
Assigning Speed Dials (on the keypad) ................................................................................ 16
6: Chain Mode .............................................................................................................................. 17
Accessing Chain Mode ......................................................................................................... 17
Leaving Chain Mode ............................................................................................................. 17
Chain Select (Browsing) ....................................................................................................... 18
Chain Run ............................................................................................................................. 18
Chain View ............................................................................................................................ 19
7: Editing Chains (on the keypad).............................................................................................. 20
Modifying Chain Links ........................................................................................................... 20
Editing the Chain Name ........................................................................................................ 21
Saving ................................................................................................................................... 21
Abandon Changes ................................................................................................................ 21

MTG

-2-

MPC Keypad v4.00

8: Utility Menu .............................................................................................................................. 22
Preset Mode Browsing .......................................................................................................... 23
Receive Program Changes ................................................................................................... 23
Edit Speed Dial ..................................................................................................................... 23
Send a Preset (via System Exclusive) .................................................................................. 24
Send a Chain (via System Exclusive) ................................................................................... 24
System Exclusive Mfg ID ...................................................................................................... 25
MIDI Pass-Thru (v3.20+) ...................................................................................................... 25
MIDI Monitor ......................................................................................................................... 26
Restore Factory Defaults ...................................................................................................... 26
Show Version ........................................................................................................................ 26
Download New Firmware ...................................................................................................... 26
Set Patch Range (v2.79, v3.30+).......................................................................................... 26
9: Using the Windows Editor ...................................................................................................... 28
Installation ............................................................................................................................. 28
Editor Features ..................................................................................................................... 29
Preset Panel ......................................................................................................................... 30
Preset Panel: Edit MIDI Data ................................................................................................ 31
Chains Panel ......................................................................................................................... 33
Speed Dials Panel ................................................................................................................ 35
Settings Panel ....................................................................................................................... 36
Toolbar File Operations ........................................................................................................ 37
MIDI....................................................................................................................................... 38
Uploading .............................................................................................................................. 41
Firmware Upgrade ................................................................................................................ 43
Appendix A: System Exclusive Implementation ...................................................................... 44
Command Types ................................................................................................................... 44
General Format ..................................................................................................................... 44
Restart Command ................................................................................................................. 45
Get Port Command ............................................................................................................... 45
Get/Set Global Parameter List .............................................................................................. 46
Get Global Parameter Command ......................................................................................... 47
Set Global Parameter Command .......................................................................................... 48
Get One Preset Command (old format) ................................................................................ 49
Set One Preset Command (old format) ................................................................................ 51
Get One Preset Command (NEW format) ............................................................................ 53
Set One Preset Command (NEW format)............................................................................. 55
Get One Chain Command .................................................................................................... 57
Set One Chain Command ..................................................................................................... 59
Universal Device Inquiry ....................................................................................................... 60
Appendix B: Sys Ex Firmware Update via MIDIOX .................................................................. 61
Configure MIDIOX ................................................................................................................. 61
Prepare the Keypad for Download ........................................................................................ 62
Test the Communication ....................................................................................................... 62
Firmware Upgrade ................................................................................................................ 63

MTG

-3-

MPC Keypad v4.00

1: Introduction
The MIDI Patch Changer is the perfect solution when you need to control MIDI
presets for one or more devices, but a giant keyboard controller or a MIDI
footswitch/pedalboard just won’t do.
The MIDI Patch Changer has all the features you'd expect in a full-featured
patch-changing controller.
o Manual Operation. Manual Mode is used to key-in or scroll-through
Program Change messages with or without MIDI Bank Select messages.
o Preset Operation. Preset mode is for live or studio performance
situations. The unit can send a complete set of 16 patch and bank select
changes for every Preset. Each Preset can contain up to 180 bytes of
other MIDI data too!
o Speed-Dials. Pick your 9 favourite Presets and access them at any time
using a hot-key1.
o Chain Operation. Chain Presets together into a list that you can navigate
through.2
o Expandable and upgradeable. The MIDI
programmable including re-flashing the firmware.

Patch

Changer

is

o Durable. Made with high-quality switches (50 million+ operations) on a
metal sub-frame.
o Stable. No PC operating system to worry about crashes, hang-ups or
viruses.
The standard unit includes:
o
o
o
o
o
o

1
2

20-key keypad with 16-character backlit liquid crystal display (LCD).
Power adapter (110-240v AC input to 5v DC output).
Rear-panel RJ connector supports multiple cable types.
RJ-to-USB cable for USB-MIDI connection (using OS built-in driver).
RJ (Cat-5) cable for 5-pin DIN MIDI In and Out (on small external box).
System Exclusive implementation for reading/storing the Presets and
other settings.

v3.10 or later.
v3.10 or later.
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Understanding the Keypad
The Mode Keys:

The MIDI Patch Changer has three
major function groups (modes).
o Manual Mode is for sending patch
changes by hand “on-the-fly”.
o Preset Mode is for sending prearranged patch changes and MIDI
data during live performance.
o Finally there is a Utility Menu for
changing the keypad preferences.
The three MODE keys indicated by the
arrows (see diagram left) are used to
change the operating mode of the
keypad.

The Numeric Key Section:
The numeric key section is used for manually entering Patch
Change and Bank Select numbers (in decimal). In each
case the number range can be 0 to 127 or 1 to 128 to match
the receiving MIDI device. Future updates may allow for
alphabetic patch numbers (some vintage synths collect
patch sets of 8 or 16 into “banks” called A, B, C, D, etc.).
In addition the ENTER keys serves as a yes/confirm key in
certain menus and likewise the CLEAR key serves as a
no/escape.

The Arrow Keys:
The up and down keys are active in all three operating modes. They are
used to manually scroll through banks and patches in Manual Mode, to
manually scroll through Presets or Chains in Preset or Chain Mode
(respectively), and to navigate the Utility Menus.
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The Other Keys
The MIDI Channel key is used to change the transmit
channel for patches in Manual Mode as well as to review the
settings for each MIDI channel in a Preset (or Chain).
The Bank MSB and Bank LSB are used to select/enable/disable the sending of
Banks Select messages in Manual Mode. In this mode they act like a mute
button.

Hooking Up
There are several ways to connect the MIDI Patch Changer to your gear and/or
PC.
5-Pin DIN MIDI Gear

RJ Cable

5v DC

Keypad
MIDI IN

MIDI OUT

OPTIONAL

If you need to connect to 5-pin DIN MIDI gear, then use the
supplied Cat5 cable and supplied MIDI adapter box.
o Plug the short Cat5 cable into the back of the keypad
and into the RS232 MIDI adapter box.
o Plug the supplied DC power adapter into the wall socket and
then into MIDI adapter box.
o Then hook your MIDI gear into the IN and OUT jacks on the
MIDI adapter box.
MTG
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USB to PC (Sequencer, Soft Synth, etc.)

USB Cable

If you are hooking the MIDI Patch Changer keypad to a
PC that has USB, then you can use the supplied RJto-USB cable:
.
o Connect the RJ end into the back of the keypad
o Then connect the USB connector into your PC or USB hub
The PC (Mac or Windows) will use the basic class drivers supplied with the OS.
No additional driver is needed.

Alternate USB to PC (Firmware Upgrade, Configuration, etc.)

RJ Cable

Keypad

MTG
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2: Manual Mode
In Manual Mode you can send one, two or all three of the following standard MIDI
messages on the MIDI channel of your choosing:
Program Change (always transmitted)

Bank Select MSB - Controller number 0 (optionally transmitted)
Bank Select LSB - Controller number 32 (optionally transmitted)

The LCD will show what the current patch value is and what components are
enabled or disabled. If one or both of the Bank Selects is disabled (muted), then
the LCD will show “···“ next to the name on the LCD. For instance, on the

LCD shown below, the Bank MSB is not enabled, the Bank LSB value is
25 and the Program Change value is 343.

MIDI Channel
Once you have your cables hooked up, the first
thing you should do is set the MIDI channel used
for manual mode. This is done by pressing the
MIDI CH key and using the Up or Down arrow
keys to scroll to the channel you want (1 to 16).
Alternatively you can erase the displayed value
using the CLEAR key and then type in the
3

As per common convention, Bank numbers range from 0 to 127 and Patch Change numbers range from 1
to 128. In both cases the underlying MIDI messages use the number range 0 to 127.
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channel you want and then press ENTER.
Press ENTER to save your new MIDI channel number. You can abandon your
changes by pressing MIDI CH a second time. The MIDI Channel value will be
retained even if power is lost.

Enable/Disable Banks Select(s)
The Bank Select MSB and Bank Select LSB can be enabled and disabled by
repeated depressing of their respective keys.

When the Bank Select is disabled (muted), the three dots appear: “···“. When the
value is being editing the cursor is flashing over the value being edited. When the
value is solid then the value is enabled for transmitting. Normally, when not
editing a bank value, the cursor is flashing over the program change value at the
far right of the LCD since this is the value you will be changing most often.

To Change a Bank Value Without Sending
This allows you to establish what patch you want to send, but not send it yet.
Press one of the Bank Select keys until you are in the edit mode (cursor flashing
on the bank value). Enter the new value for the Bank Select using the number
keys. Press the same Bank Select key again (do NOT press Enter). This
changes the value on the display but does not transmit anything.

To Change a Bank Value With Sending
To Edit a Bank Select and send it immediately (along with the current Patch
value), press one of the Bank Select keys until you are in the edit mode (cursor
flashing on the bank value). Enter the new value for the Bank Select using the
number keys. Press Enter.

MTG
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To Send the Bank and Patch Values
While in Manual Mode, pressing Enter at any time causes all of the displayed
(enabled) data to be transmitted.

Scrolling through Patches
With the cursor flashing on the Patch value, pressing an Up or Down arrow key
causes the displayed patch value to be incremented or decremented by one, and
the new displayed (enabled) data to be transmitted.
If the Patch value overflows or underflows, then the Bank Value (if enabled), is
modified by one also. This allows you to scroll seamlessly over bank boundaries
in both the forward or reverse direction.

Using the Arrow Key on a Bank Select
To quickly change to the next or previous bank, put one of the Bank Select value
in edit mode and press the desired Up or Down arrow key. This will cause the
Bank Select value to change by one, followed by transmission of enabled data.

MTG
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3: Preset Mode
Preset mode allows you to pre-configure the keypad for performance situations
where you need to change patches on a lot of gear with minimum fuss. In this
mode you can set up to 16 patch/bank changes per Preset (one per MIDI
channel). Of course you will need to set these values up ahead of time. This is
normally accomplished by using the Librarian Software or by manually sending
System Exclusive dumps (see Appendix A for a description of the System
Exclusive implementation).
There are 200 Presets (1-200) and you can move
through them using the number pad or with the
arrow keys (either “browsing” or “live” depending
on user preference).4
The number on the left indicates the Preset number. The user name for the patch
is shown on the right. It consists of (up to) thirteen ASCII characters. Each time a
new Preset is selected the keypad can transmit any or all of the following
information:
Blank Preset Sheet
Pre-Patch Arbitrary MIDI Data:
MIDI
Bank Select
Channel
MSB (0-127)
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
Post-Patch Arbitrary MIDI Data:

Bank Select
LSB (0-127)

Program Change
(1-128)

4

As of v0.76 Preset browse mode allows for scrolling through the presets with the arrow keys without
transmitting. Use Enter to transmit the preset you browsed to. This is defined in a UTIL setup menu.
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Changing Presets By Number
When you begin to type in a number on the number pad, the display briefly
changes to show only the number being entered in.

When you have completed typing in the Preset number you want, press the
ENTER key. The complete Preset will be transmitted and the display will return
to the standard screen. While entering the number, you can also edit the value
using the CLEAR key.

The MIDI Channel Key
In this mode, the MIDI Channel key is used to browse through the table values
shown on the previous page. Select a Preset using the number pad or the arrow
keys. Press MIDI CH. The display will show, for each MIDI channel, what
elements are being transmitted. Again, values that are disabled are shown with
three dots: “···“.

The LCD elements shown from left to right are:
o
o
o
o
o

The C: indicates that you are browsing the data for each MIDI channel.
MIDI channel (1 to 16).
Bank Select MSB (user settable).
Bank Select LSB (user settable).
Program Change (user settable).

You can then use MIDI CH or the arrow keys to scroll through the MIDI channels
and see what you have previously programmed into the device. Any other key
exits this browse mode (acts as an Escape key).

Arbitrary MIDI Data
Each Preset can also send up to 90 bytes of arbitrary MIDI data before and up to
90 bytes of arbitrary MIDI data after the patch change data. This data cannot be
edited on the device at this time. Use the Librarian Software (PC Editor) to
configure this data.
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4: Editing Presets (on the keypad)
You can edit the individual Presets on the device or by sending new values using
System Exclusive. To edit a Preset on the device, while in Preset Mode, press
PRE MODE (again). You will asked to verify that you want to edit the current
Preset:

Press ENTER to confirm or CLEAR to go back to the previous Preset. In Edit
Preset mode the LCD screen information starts with E:.

You can cycle through the various edit screens using the PRE MODE key.
Sub-menu

Navigation
PRE Mode Key

Edit Patch Change Data
Edit Name
View Pre-Patch MIDI Data
View Post-Patch MIDI Data
Save Preset Confirm

Modifying the Preset
In Preset Edit mode, the editing is similar to the Manual Mode.5
MIDI CH lets you scroll through the list of 16 MIDI channels and on each one you
can assign a Bank Select MSB and/or a Bank Select LSB and/or a Patch Change
value.
Bank MSB moves the cursor to the Bank Select MSB if the cursor is not there
already. If it is, then it enables/disables it. If the Bank Select MSB is enabled and
the cursor is flashing on it’s position, then you can modify the value using either
the arrow keys or typing a new value on the keypad.
Bank LSB moves the cursor to the Bank Select LSB if the cursor is not there
already. If it is, then it enables/disables it. If the Bank Select LSB is enabled and
5

There is no method currently to modify the pre and post arbitrary MIDI data fields on the keypad.
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the cursor is flashing on it’s position, then you can modify the value using either
the arrow keys or typing a new value on the keypad.
MAN MODE takes on the role of PATCH CHANGE. It moves the cursor to the
Patch Change value if the cursor is not there already. If it is, then MAN MODE
enables/disables it. If the Patch Change is enabled and the cursor is flashing on
it’s position, then you can modify the value using either the arrow keys or typing a
new value on the keypad.

Editing the Preset Name
Press PRE MODE again and you will be prompted for
the name you wish to assign to the Preset. The LCD
screen shows N?: to indicate that it is in name editing
mode.
Use the UP and DOWN arrow keys to change each
character value (see table). ENTER moves the cursor
to the right and CLEAR moves it to the left.
You can also use the 0 to 9 keys to enter numbers
directly.
If you wish to blank out the name in order to start
editing with a blank slate, press CLEAR until the
cursor is at the far left. Press it one more time and the
display shows "Clear Name?". At this point you can
press ENTER to confirm or CLEAR to abandon name
clearing.6

LCD character table

6

v3.10 and later.
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Pre/Post-Patch Arbitrary MIDI Data
Press PRE MODE one more time to take you to the screen that shows the first 6
bytes of Arbitrary MIDI Data (if used). The LCD shows Pre: followed by the data,
if any. One more press and the LCD shows Pst: followed by the data, if any.

Saving
To save the Preset, press PRE MODE one more time and you will be prompted
to save the changes. Here you can also edit the Preset number. This allows you
to save the Preset to the same location or you can copy the Preset to a new
location. Once you set the number of the Preset location you want to save to,
Press ENTER to confirm the save.
Alternatively, pressing PRE MODE again takes you back to editing without
saving.

Abandon Changes
If you want to abandon the changes, press the UTIL MENU button to switch out
of editing.
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5: Using Speed Dials
Preset Mode Speed Dials
You can select any 9 Presets and assign them to be Speed Dials (favourites).
Once they are assigned, you can launch a Speed Dial from the Preset screen by
pressing and holding CLEAR and then tapping on one of the speed dial numbers
1 to 9.
When you press and hold CLEAR, you will see
Speed Dial #?
As soon as you tap on the number key, the Preset you have assigned will be
fired off and the screen will reflect that you have sent that Preset:
MIDI Sending . . .
The new Preset will now become the active Preset and the LCD will reflect that:

A Speed Dial can contain any valid Preset number from 1 to 200. If the number is
out of range (say 0 or above 200), then the Speed Dial is considered “empty” and
you will see “…“ when you look at the value from the edit menu.

Assigning Speed Dials (on the keypad)
Speed Dials (favourites) as assigned using the Utility Menu or by sending Set
Parameter MIDI commands using System Exclusive.
See Section 8: Utility Menu on how to configure your keypad using the setup
menus.
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6: Chain Mode
If Presets can be likened to parts in a song (verse, chorus, etc.), then Chains can
be likened to songs. You can link 18 Preset “parts” into a Chain “song” that can
be navigated through quickly and easily. The device will store 99 Chains.
Chains can be created and edited on the keypad or they may be created using a
PC editor and downloaded to the keypad using System Exclusive MIDI
commands.

Accessing Chain Mode
Chain mode is a variation on Preset mode, so it is accessed using a special key
combination. From within Preset mode, press and hold the CLEAR key. While
the key is held down you will see the following message on the LCD:
Speed Dial #?
Now tap the PRE MODE key. The unit will switch to Chain Select mode and you
should see something like:

The display is very similar to the Preset one. In this case the first element is the
Chain number (1 to 99) followed by an arrow, followed by the Chain name.

Leaving Chain Mode
You can leave Chain mode in several ways, depending on what you want to do.
MAN MODE will take you to Manual mode and UTIL MENU takes you to the
setup menus. If you want to go from Chain mode directly to Preset mode then
you need to make use of the CLEAR key again. In this case, press and hold
the CLEAR key. While the key is held down you should see the following
message on the LCD:
PRE exits Chain
Now tap the PRE MODE key to return to regular Preset mode.
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Chain Select (Browsing)
While in Chain Select mode you can see the Chain number followed by the
Chain name. At this point you are browsing through the Chains and nothing is
being sent over MIDI. You can browse by using the Up and Down arrow keys.

Chain Run
As you are browsing through the Chains using the arrow keys, you can launch
the Chain using the ENTER key once you have located the Chain you are
interested in. Alternatively, while browsing, you can simply enter the number of
the Chain you want using the 0 to 9 keys and then press ENTER. Using either
method, once you launch the Chain, the first link in the Chain (the first Preset) is
immediately transmitted over MIDI. You will also see the LCD change to reflect
that you are now in Chain Run mode.

The C:01 indicates that Chain #1 is running. The first number (001) is the current
Preset. This will be one of the Preset numbers from 1 to 200. This data has
already been sent over MIDI. Then we see the Chain mode “arrow” again.
Finally we see the second number (002). This is the next link (next Preset) in the
chain. Again it will be another Preset number from 1 to 200.
You move forward and backward in the Chain using the Up and Down arrow
keys. Each time you press an arrow key, the new current Preset is transmitted.
At any time if you press the ENTER key, the current Preset will be re-transmitted.
The end of the Chain is denoted by the “…“ symbol. This symbol means that the
link has no Preset defined for it (it is empty).
Whether you are in Chain Run or Chain Select, if you type in a number and press
ENTER, that particular Chain will be launched immediately.
To exit Chain Run mode, press the CLEAR button to return back to Chain Select
mode.

MTG

- 18 -

MPC Keypad v4.00

Chain View
If you recall Preset mode, pressing MIDI CH allowed you to view (but not edit)
the contents of a Preset. Similarly, while in Chain Select mode if you press MIDI
CH you can view, but not edit, the links in the current Chain.
In this view you can see the Chain #, the link # and the Preset stored in that link:
Chain.22 [01] = 123
The format of the LCD is

Chain.chain#[link#]=preset#

Use the Up and Down arrow keys to scroll through the 18 links in the Chain to
see what Presets are assigned to the links in the Chain. Press CLEAR to return
to Chain Select mode.

MTG
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7: Editing Chains (on the keypad)
To edit a Chain on the device, while in Chain Select mode, press PRE MODE.
You will asked to verify that you want to edit the current Chain:
Edit Chain 01 ?
Press ENTER to confirm or CLEAR to go back to the previous screen. In Edit
Chain mode the LCD screen looks like this:
Link [ 01 ] = Pre : 001
You can cycle through the various edit screens using the PRE MODE key.
Sub-menu

Navigation
PRE Mode Key

Edit Chain Links
Edit Chain Name
Save Chain Confirm

Modifying Chain Links
Editing Chain links is simple:


The Up and Down arrow keys allow you to move through the 18 links that
make up a Chain.



The 0-9 number keys are used to enter the Preset number that you would
like to associate with that Chain link.



The CLEAR key is used to remove (delete) a Chain link. In all cases, after
removing a link, the last link in the Chain (#18) will be “empty”.



The ENTER key is used to insert a Chain link. In all cases, after inserting
a new link, whatever was in link #18 will be pushed off then end and lost.
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Editing the Chain Name
Press PRE MODE (again) and you will be prompted
for the name you wish to assign to the Chain. The
LCD screen shows N? to indicate that it is in Chain
name editing mode.
Use the UP and DOWN arrow keys to change each
character value (see table). ENTER moves the cursor
to the right and CLEAR moves it to the left.
You can also use the 0 to 9 keys to enter numbers
directly.
If you wish to blank out the name in order to start
editing with a blank slate, press CLEAR until the
cursor is at the far left. Press it one more time and the
display shows "Clear Name?". At this point you can
press ENTER to confirm or CLEAR to abandon name
clearing.

LCD character table

Saving
To save the Chain, press PRE MODE one more time and you will be prompted to
save the changes. Here you can also edit the Chain number. This allows you to
save the Chain to the same location or you can copy the Chain to a new location.
Once you set the number of the Chain location you want to save to, Press
ENTER to confirm the save.
Alternatively, pressing PRE MODE again takes you back to editing without
saving.

Abandon Changes
If you want to abandon the changes, press the UTIL MENU button to switch out
of Chain edit mode.
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8: Utility Menu
The menu structure for editing on the MIDI Patch Changer keypad looks like this:
Operating Mode

Sub-menu

Navigation

Manual Mode
PRE

Preset Mode Edit Patch Change Data
Edit Preset Name
View Pre-Patch MIDI Data
View Post-Patch MIDI Data
Save Preset Confirm
PRE

Chain Mode Edit Chain Links
Edit Chain Name
Save Chain Confirm
UP/DN

Utility Menu Preset Mode (norm/browse)
Receive Program Change
Edit SpeedDial
Send a Preset (via Sys Ex)
Send a Chain (via Sys Ex)
Send Everything (v4.00+)
Sys Ex Manufacturer ID
MIDI Pass-Thru
MIDI Monitor
Restore Factory Defaults
Show Version Info
Download New Firmware
Set Patch Range
To view the Utility Menu, press the UTIL MENU key, then navigate the menu
using the Up and Down arrow keys. The vertical line at the far right of the LCD
is meant to mimic a window scroll bar on a PC. As you move up and down the
menu the scroll bar indicates your relative position in the menu tree.
Press ENTER on the item you wish to view/modify. From within a menu item you
can press CLEAR to abandon a change and return to the menu list.
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Preset Mode Browsing
With Preset Mode set to NORMAL, using the arrows keys (or ENTER or typing a
preset number in) causes an instant Preset data transmit.
With Preset Mode set to BROWSE, the arrow keys do NOT cause a data
transmit. Therefore in browse mode you can scroll through your list of presets
until you find the one you like, then send it using the ENTER key.

Receive Program Changes
The unit can be set to accept program change commands on its MIDI IN. This
allows an external device to send a patch change command to the MIDI Patch
Changer, thus triggering a specific Preset. Beware of MIDI loops if you use
this! This parameter can be turned OFF, set to a single MIDI channel (1 to 16)
on which to receive the program change commands, or ALL channels (v3.30+).
Note that received program changes 1 to 127 are assigned to Presets 1 to 127.
The other Presets (128 to 200) cannot be accessed in this fashion.

Edit Speed Dial
You can define the Presets that are assigned to Speed Dial #1 through Speed
Dial #9 using this setup menu.
When editing the Speed Dials, the Up and Down arrow keys change the Speed
Dial number.
Start typing a number to enter the Preset number that you would like to assign.
Key in a Preset number from 1 to 200 using the 0 to 9 number keys. Press
ENTER to save the changes. CLEAR can be used to correct typing mistakes.
SD 1 is Pre #: 123
There is no real need to erase a Speed Dial, but in the unlikely event you wish to
empty a slot, simply enter a Preset number outside of the valid range 1 to 200
(say, zero). When empty, you will see “…“ instead of the Preset number.
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Send a Preset (via System Exclusive)
You can send one Preset manually to a host PC using this menu. Type in the
number of the Preset you wish to transmit (1 to 200) and press ENTER. The
keypad will send the Sys Ex data (as described in the appendix).
Make sure your PC is set to NOT echo the data back out again to the Keypad!

In order to send a Preset to the keypad, simply send it at any time from your PC.
The keypad is always ready to receive Sys Ex. It does not have to be configured
to receive Sys Ex (make sure you are using the correct device ID).

Send a Chain (via System Exclusive)
You can send one Chain manually to a host PC using this menu. Type in the
number of the Chain you wish to transmit (1 to 99) and press ENTER. The
keypad will send the Sys Ex data (as described in the appendix).
Make sure your PC is set to NOT echo the data back out again to the Keypad!

In order to send a Chain to the keypad, simply send it at any time from your PC.
The keypad is always ready to receive Sys Ex. It does not have to be configured
to receive Sys Ex (make sure you are using the correct device ID).

Send Everything (via System Exclusive) (v4.00+)
Sends all the Presets, Chains and Speed Dials in one go.
MTG
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System Exclusive Mfg ID
The System Exclusive Manufacturing ID is used to uniquely identify a specific
MIDI device while doing Sys Ex dumps from a host PC. You can adjust the Sys
Ex ID of the MIDI Patch Changer keypad so that it does not conflict with any of
your other MIDI gear.

The displayed value is in hexadecimal (since that is the most common format for
these IDs). You modify the value using the Up and Down arrow keys. Press
Enter once you have made your selection. Remember to use the value you set
when doing System Exclusive communications with the keypad.
NOTE: The free editor/librarian does not yet support alternate Mfg IDs!

MIDI Pass-Thru (v3.20+)
MIDI Pass-Thru is like a poor man's MIDI-merger. Everything at the MIDI Input is
echoed at the MIDI output with only 350uS delay. This can simplify cabling if the
MPC keypad cannot be connected at the top of the MIDI food chain.
There are, however, two caveats. One, you must remember to turn MIDI PassThru off when you are configuring the keypad by PC. The MIDI echo can
cause an endless loop.
The other caveat is that this is not a true merge. It may be possible for MIDI
messages to be confused if the MPC keypad transmits data at the same instant
as it receives/forwards data. If you require both the MPC keypad and (say) some
sequencer to be active at the same instant, it is recommended you disable MIDI
Pass-Thru and add a true MIDI Merger device to your rig.

To remind you to turn MIDI Pass-Thru off before connecting to a PC, the LCD will
show “MIDI PassThru ON” every time the keypad powers on (if Pass-Thru is
indeed on).

MTG
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MIDI Monitor
You can set the MIDI Monitor ON or OFF. This is a very simple one-line display
showing the last MIDI command received. When enabled, the monitor data is
overlaid live on the MIDI Patch Changer LCD regardless of mode or menu. Press
any keypad key to temporarily regain control of the LCD. This setting is not
retained in non-volatile memory.

Restore Factory Defaults
This utility function allows you to restore the whole MIDI Patch Changer keypad
to the default factory settings. This is recommended after any firmware upgrade.
NOTE: After the erase/rebuild operation the keypad will automatically reboot, so
if you are connected via USB MIDI, any applications talking to the MIDI keypad
will be “orphaned”. This is the nature of USB. Therefore it is recommended that
you close any open MIDI applications BEFORE you perform the reset (otherwise
you may need to restart any application that is talking to the keypad).

Show Version
Displays the firmware version number (the “OS” version number) of the keypad.

Download New Firmware
The MIDI Patch Changer will accept .SYX firmware upgrades over 5-pin DIN
MIDI (not USB) from a PC. Download the latest firmware executable from the
website and follow the instructions included with it or Appendix B.

Set Patch Range (v2.79, v3.30+)
You can set the range for the Patch Change values to be 1-128 or 0-127.
Underneath, the firmware always transmits the hex values according to the MIDI
Spec. (0x00 to 0x7F), but most MIDI gear uses 1 to 128 for patches.
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You can modify the value using the Up and Down arrow keys or the 0 and 1
keys. Press Enter once you have made your selection.

MTG
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9: Using the Windows Editor
Please Note: If you wish to craft an editor for another platform, please refer to the
system exclusive implementation in the appendix.

You can edit the individual Presets on the device or by sending new values from
a PC using the free editor/librarian (or manually using hand-crafted System
Exclusive data).
The changes made in the editor application can be sent to the keypad directly
from the editor application or transported via a 3rd party application such as
Bome’s SendSX, MIDIOX (or similar) if you prefer.
To edit a preset on a Windows PC, install the free MIDIPatchChanger.exe
librarian utility.
If you choose to use MIDIOX to transport the “Sys Ex” files, download it at
http://www.midiox.com .
SendSX is available at http://www.bome.com/products/sendsx .

Installation
MIDIPatchChanger.exe is a standalone program. There are two ways to install
and use it. The first (recommended) way is to use the installation program. This
will install the application in
C:\Program Files (x86)\MusicTechGroup\MidiPatcher
Alternatively you can download and unzip just the exe file and place it where you
like. On first run, the exe attempts to create a directory for your user files at
C:\Users\username\Documents\MusicTechGroup\MidiPatcher\Syx
And on that first run it will try and copy two example files from the EXE\Syx
directory to your documents area.
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Editor Features

There are a couple of main areas to note:




MTG

The top toolbar consists of buttons used for file open/save/download and
similar operations.
The large main tabbed panel has four tabs: Presets, Chains, Speed Dials
and Settings. These four panels are where most of the editing takes place.
Finally, the collapsible list to the right shows all the Presets.
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One important point to consider is this: you should finalize your Preset positions
before making your Chains (or less importantly Speed Dials). Otherwise, moving
your Presets around after your Chains have been built might leave your Chains
with the wrong Presets in the Links.

Preset Panel
For each Preset, 1 to 200, you can setup the MSB/LSB Bank Select and
Program Change data for any or all of the 16 MIDI channels. In addition you can:




Name each Preset (13 characters maximum).
Optionally setup the arbitrary MIDI data that is sent before the patch
change(s).
Optionally setup the arbitrary MIDI data that is sent after the patch
change(s).

To change to a new Preset, use the Preset Selection List to the right.
You can show or hide the list at any time using the show/hide button.
Single-click on the list to select a new Preset for editing. Alternatively, you
can use the keyboard up and down arrows to navigate the list.
You can rearrange single Presets in the list by dragging a Preset to a new
spot in the list.
If you don’t want to use the Preset List, you can also change Presets using the
PageUp and PageDown keys if the cursor is in the Name: edit box. (v3.33+ only)

By default all of the Bank Select and Program Change values are disabled
(grayed-out). Click on the checkbox next to the item you wish to enable/disable.

NOTE: At this time the editor only supports the default Mfg ID. In addition, the
editor supports Bank Select numbering 0-127 and Program Change numbering
1-128 only. This is the normal MIDI convention.
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Preset Panel: Edit MIDI Data
Click on either Edit button in the Pre-Patch or Post-Patch Arbitrary MIDI Data
boxes. This will open up the MIDI Data editor.

MTG
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The keypad allows you to send up to 90 bytes of any MIDI data before and/or
after the MIDI Patch Change and Bank Selects. This might consist of controller
changes or Sys Ex commands.
The top box, marked Type: Predefined, allows you to insert data using one of
the shown predefined types. You can even embed more patch changes or
System Exclusive data here. Or perhaps a volume or other controller setting
(though this is probably better served in the POST-data area).
As you make changes using the sliders in the predefined area, the status bar at
the very bottom shows what data would be inserted when you click the Insert
button.
The center box, marked Type: Custom, lets you enter any data of your
choosing. The value 255 (0xFF) is reserved and cannot be used. You can enter
the data using decimal or hex. The table of results at the bottom shows the
cumulative MIDI data in hexadecimal format.
The delay slider is used to insert a 0 to 127ms delay between each byte in the
resulting table. Some synths cannot accept control data sent at full speed without
short pauses between bytes. If you are having problems, try setting the delay to
max and slowly reduce it after you have confirmed correct operation. This will
allow you to focus on getting the operations setup correctly, and later optimizing
for speed.

Use can use the mouse to select a point in the MIDI data table to work on. To
erase an individual byte, double-click the table cell.
Once you are happy with your created MIDI data, click Accept to close the MIDI
data editor. If you need to erase your MIDI data and start over, click Erase All.
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Chains Panel
A Chain is a series of Presets that you progress through in order, for instance as
you play a song live. The MIDI Patch Changer keypad holds 99 Chains, each of
which can hold 18 Presets.
Chains are selected using the Chain Selection list on the left. The Links in a
given Chain are shown beside it to the right. There can be no gaps in the Chain
Links. Once the keypad encounters an empty link, that link is considered the end
of the Chain.
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You add Links (Presets) to the Chain by double-clicking on the Preset list to the
far right. Normally you would append Presets to the end of the Chain, but you
can move the insertion point with the mouse.
To erase a Link, double-click on it. To erase the whole Chain, right-click on the
Chain Links and then select “Delete All Links”.
You can name your Chains with up to 13 characters (same as with Presets).
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Speed Dials Panel
You can have up to 9 favourite Presets than can be selected from Preset mode
at any time using a hot-key combination. To access them on the keypad, start in
Preset mode, then press and hold CLEAR. While holding CLEAR down, press
one of the 0 to 9 number keys. The Preset assigned to that Speed Dial will be
launched.

Adding Presets to Speed Dials is very similar to adding Presets to a Chain. In
this case, simply select the Speed Dial of interest then double-click on the name
of the Preset you wish to assign to that Speed Dial.

MTG
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To delete a Speed Dial, double-click it.
Note that unlike Chains, Speed Dials do not push later Presets down when
adding them in the middle. This is intentional.

Settings Panel
The Settings Panel allows you to view some of the Keypad Properties. These are
global values set by using the UTIL Menu on the keypad itself.

MTG
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Toolbar File Operations
All of the files used by the editor/librarian are System Exclusive files and all use
the “.syx” extension. For the purposes of this program we distinguish between
the three file types used by the software as follows:
1. A single-Preset file (mostly used for reading in a Preset from an older
version of the software). You can also save/download a single Preset to
test it quickly rather than waiting for a complete download.
2. A “complete” SYX file containing all of the Keypad parameters (200
Presets, 99 Chains and 9 Speed Dials).
3. A firmware upgrade file used to “re-flash” the keypad OS.
Because they all use the .syx extension, you should use very descriptive names
to differentiate between the files and file types or it will be confusing later on
when you work with your files.
The Presets can be stored individually or as a bulk set of 200 in .syx (raw System
Exclusive) file format. These files can be loaded into any software that operates
directly on such files (e.g. MIDIOX). Single Preset .syx files contain the target
preset # (see Appendix A for more information) and are formatted as a Set One
Preset command. Thus any sequencer or software or device that can load this
data can be used for programming a Preset into the keypad.

From the toolbar menu you can perform the following actions:
o MIDI – Allows you to choose which MIDI connection/method is used to talk
to the keypad.
o New – Erases all the current data and starts with the default settings
(same as exiting the program and restarting it again).
o Open – Import 1 Preset –or– read in a .SYX file containing “everything”.
o Save – Export 1 Preset –or– save “everything” to a .SYX file.
o Download – Downloads 1 Preset or all Presets/Chains/etc either directly
to the keypad or via the external MIDI transport application.
o Upgrade – Performs a firmware upgrade of the keypad.
o Help – About box (version info) and access to this PDF user manual.
o Exit – Closes the application.
MTG
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MIDI
There are several ways to manage and send the data to the keypad. These
methods differ more in the way the file is managed rather than how the cabling is
hooked up.

1. File Only. In this case you don’t update the keypad. You only work with
files. Later on you can download your files to the keypad. This choice will
also close the MIDI ports if they were opened using MIDI Interface, below.
2. MIDI Interface. Send data directly from within this editor/librarian to the
keypad. In this case the keypad is either connected using its USB cable or
it is connected through your existing MIDI interface (5 pin DIN MIDI). This
is the most common setting. You will need to choose your USB
connection from the list of available interfaces.
3. External Application. In this case files created by the editor/librarian are
passed to an intermediate 3rd party application (such as SendSX or
MIDIOX) for transport. You would choose this method if you prefer to work
at a low level with your MIDI data.

MIDI Port Selection
Hook-up your keypad. Click on “Send to MIDI
Interface…” and choose the MIDI interface
you want to work with.
If the keypad is connected you will see its
version information displayed on the status
bar at the bottom of the program.

External Application Selection
If you prefer that your MIDI files be transported to the keypad using a 3rd party
application, choose “External File Application”. The editor/librarian will then open
the default application the OS has configured for the .SYX file type. Your 3rd
party application will then need to choose which MIDI interface to use.
MTG
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Notes for MIDIOX
At this time we take a moment and a few pages to discuss how one might use and external MIDI
application such as MIDIOX … if that’s your thing.
If you are using MIDIOX, you should set up MIDIOX’s SysEx configuration.
recommended settings can be entered by clicking:
View -> SysEx…

then

The following

SysEx->Configure .

Once MIDIOX is configured and you have a Preset edited to your liking, you can download it to
the keypad by following these steps:
o
o
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Click on Download. Then choose whether you want to send one or all.
If you choose one, then you must choose which Preset slot you wish to save it to (this
value is embedded into the .SYX file) and then click on Continue. The data will be
written to an intermediate .SYX file.
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o

Enter a name for the Preset. You may wish to use the same name as the keypad shows
on it’s LCD. Then click on Save.

o

The preset file will be saved to disk and then opened in the MIDIOX Sys Ex window.

o

At this point you simply click on Command Window -> Send/Receive SysEx.

MTG
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o

After a moment you should receive a 7-byte ACKnowledge packet (F0 7D 22 24 00 41 F7
or similar). Click on Done. Downloading occurs in the background on the keypad so
even though the keypad has been programmed, the LCD display is not automatically
updated until you do something on the keypad that requires the LCD to be refreshed
(E.g. change modes or presets).

Close the SysEx window in MIDIOX and when prompted to save the received data, click on No.

Uploading
This is not a function you would normally need to perform. Uploading is most easily accomplished
using the keypad UTIL MENU key. Close and Open a fresh MIDIOX SysEx window and then click
on
SysEx -> Receive Manual Dump…

MIDIOX then waits for the data from the keypad.
Next, on the keypad, from the UTIL menu, choose the keypad
menu item Send a Preset and enter a number (1 to 100):

MTG
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When you press ENTER on the keypad the data will be sent to MIDIOX.

Click Done and then save the data by clicking on
Display Window -> Save As…
Choose a suitable file name (using the default extension of .SYX). By default the file will be
saved in the Syx subdirectory of MIDIOX. You can load that file into MIDIPatchChanger.exe if
you wish to edit it.

… end of Notes for MIDIOX.
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Firmware Upgrade
New operating system code is made available on the website. This
code can be used to “reflash” the firmware in the keypad. These
files can be sent to the keypad using the editor/librarian, SendSX
or MIDIOX (or similar). Either way, the keypad must be connected
to the PC using its 5-pin DIN interface box (not via USB).
To perform the upgrade from within the editor/librarian, simply choose your
(Direct) MIDI connection, click the Upgrade button, set the keypad to upgrade
mode (see below) and select the file to download.

There are two ways to set the keypad in a mode that accepts new firmware.
1. The first method is using the UTIL menu. Press the UTIL button and then
press the down arrow key repeatedly until you see the menu item:

Press ENTER and when prompted to confirm (ENTER to upgrade),
then press ENTER again. At this point the MIDI Patch Changer passes
control to the internal MIDI Loader.
MidiLoader v2.00
2. The other method can be used even in the unlikely event that you “brick” the
firmware (cause the device to malfunction due to improper reprogramming).
In this case unplug the keypad. Press and hold down CLEAR and ENTER.
With these two keys down, plug in the powered 5-pin DIN cable/box. Once
power has been applied through the box to the keypad, release the keys. You
should see:
MidiLoader v2.00

To perform the upgrade using MIDIOX, see Appendix C.
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Appendix A: System Exclusive Implementation
In order to understand the System Exclusive data presented in this chapter you
will need to have a working understanding of hexadecimal numbers. There are
many fine tutorials on the internet that explain hex as it relates to MIDI.
Note: The “old” v2.xx Get/Set One Preset system exclusive message was not
flexible enough to support the changes we wanted for v3.xx so a “new” Preset
format was added. Both old and new format presets can be loaded into the latest
keypads.

Command Types
The table below shows the system exclusive commands supported by the MIDI
Patch Changer. The keypad also responds to a Universal Device Inquiry system
exclusive command.
Command (hex)
04
05

Description
Restart
Get Port

21
22

Get Global Parameter (see list)
Set Global Parameter (see list)

23
24
*
30
31*

Get One Preset (old format)
Set One Preset (old format)
Get One Preset (new format)
Set One Preset (new format)

32
33

Get One Chain
Set One Chain

Size (# bytes)
5
5
8
8
6
Up to 153
7
Up to 500
58
58

General Format
Roughly speaking, all the MIDI commands look something like this:
(hex)

F0
<id>
22
<cmd>
<addr>
(data)
F7

System Exclusive
Manufacturer ID. User settable – default is 7D.
Device ID for the MIDI Patch Changer.
Command type byte from table above.
Parameter # (0x08 to 0x19) or old Preset # (0x00
to 0x63) or new Preset # (using two bytes).
Data (if any). The data format is described below.
End of System Exclusive (EOX)

*

As of v3.00+. All Presets are stored internally using the “new” format which allows for more Pre- and
Post- Patch MIDI data.
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Restart Command
You can command the keypad to reboot by issuing this command. If you are
connected using USB, then you may need to close and reopen the ports in your
MIDI software.
Transmitted:
(hex)

F0
7D
22
04
F7

System Exclusive
Manufacturer ID. User settable – default is 7D.
Device ID for the MIDI Patch Changer.
Command type.
End of System Exclusive

Received: ACK packet (then the keypad reboots)
(hex)

F0
7D
22
04
00
41
F7

System Exclusive
Manufacturer ID. User settable – default is 7D.
Device ID for the MIDI Patch Changer.
Echo of whatever the command was.
Echo of parameter(none in this case).
‘A’ – ACK – ACKnowledge
End of System Exclusive

Get Port Command
You can query the keypad to determine if the keypad is connected using it’s 5-pin
DIN cable/box or it’s USB cable using this command.
Transmitted:
(hex)

Received:
(hex)

F0
7D
22
05
F7

System Exclusive
Manufacturer ID. User settable – default is 7D.
Device ID for the MIDI Patch Changer.
Command type.
End of System Exclusive

F0
7D
4D or 55

System Exclusive
Manufacturer ID. User settable – default is 7D.
4D = ‘M’ = MIDI
55 = ‘U’ = USB
Command type.
End of System Exclusive

05
F7

MTG
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Get/Set Global Parameter List
The following table describes the address and data elements that are valid for
the Get/Set Global Parameter commands.
Parameter #
(hex)
08

Combined Byte
Value
(binary)
0000 nnnn

Description

09

0000 000x

0A

0000 000x

0C

0ddd dddd

0D

0000 000b

Keypad beeper enable.

0E

0000 000m

0F

0000n nnnn

10 to 19

pppp pppp

1A

0000 000m

m = 0 = Preset Mode NORMAL
m = 1 = Preset Mode BROWSE
0
= Do not receive program change.
1-16 = Rx Pgm Chg on ch 1 to 16.
17 = Rx Pgm Chg on ALL channels.
Preset number assigned to Speed Dial
(0 to 199 decimal corresponds to
Presets 1 through 200).
m = 0 = MIDI Pass-Thru OFF
m = 1= MIDI Pass-Thru ON7

n = MIDI Channel for manual mode
0 to 15 (for MIDI channels 1 to 16)
x = Program Change number range
0 is 0-127
1 is 1-128
x = Bank Select number range
0 is 0-127
1 is 1-128
d = Sys Ex Mfg ID (default is 7D)
01 to 7D (7E and 7F are reserved)

Crossed out commands are not recommended. Using other parameter numbers is undefined.
Program Change Range works in v2.79 and then v3.30+, not in between

7

MIDI Pass-Thru should always be OFF when configuring the keypad over MIDI! Attempting to
communicate with the keypad over MIDI while it is ON will be fruitless!
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Get Global Parameter Command
By sending a Get Global Parameter Sys Ex command from a host device, the
user can query the settings (similar to using the keypad’s Utility menu). In this
implementation one parameter byte is read at a time from the table listed above.
Byte addresses outside of the parameter list range are ignored.
The command reads/writes a single byte parameter from the keypad, but the
data value is split and received as two (nibble) bytes over MIDI. The first byte is
the most significant nibble of the data. The second byte is the least significant
nibble of the data.
Example: Read the Manufacturer ID
Transmitted:
(hex)

Received:
(hex)
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F0
7D
22
21
0C
F7

System Exclusive
Manufacturer ID. User settable – default is 7D.
Device ID for the MIDI Patch Changer.
Command type (get parameter command).
Parameter # from parameter list table (ie. Mfg ID).
End of System Exclusive

F0
7D
22
21
0C
07
0D
F7

System Exclusive
Manufacturer ID. User settable – default is 7D.
Device ID for the MIDI Patch Changer.
Command type.
Parameter # from parameter list table.
Most significant nibble of the value 7D.
Least significant nibble of the value 7D.
End of System Exclusive
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Set Global Parameter Command
By sending a Set Global Parameter Sys Ex command from a host device, the
user can change the settings that normally require the use of the Utility menu. In
this implementation one parameter byte is changed at a time from the parameter
list table. Byte addresses outside of the parameter list range are ignored.
The command writes a single byte into the keypad, but the new data value is
transmitted as two (nibble) bytes. The first byte is the most significant nibble of
the data. The second byte is the least significant nibble of the data.
In the case of Speed Dials (parameters 10 through 19 hex), you can erase a
Speed Dial by setting its value to either 0 or FF (hex).

Example: Set Speed Dial #1 to preset # 100 (in Sys Ex Presets numbers are
one lower, so we use 99 decimal or 0x63 hex).
Transmitted:
(hex)

F0
7D
22
22
10
06
03
F7

Received: ACK packet
(hex)
F0
7D
22
22
10
41
F7
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System Exclusive
Manufacturer ID. User settable – default is 7D.
Device ID for the MIDI Patch Changer.
Command type (set parameter).
Parameter # from parameter list table.
Most significant nibble of the value 63.
Least significant nibble of the value 63.
End of System Exclusive

System Exclusive
Manufacturer ID. User settable – default is 7D.
Device ID for the MIDI Patch Changer.
Echo of the command (set parameter).
Echo of parameter #.
‘A’ – ACK – ACKnowledge
End of System Exclusive
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Get One Preset Command (old format)
By sending a Get Preset Sys Ex command from a host device, the user can
query and save the settings for a single Preset. A Preset (old format) consists of
the following data:
o 13 character ASCII name
o 16 MIDI channels worth of Bank MSB/Bank LSB/Patch Change. The
values for these bytes are 0x00 to 0x7F regardless of user preferences.
Disabled (unused) values will be 0x80 or 0xFF. These values are
transmitted as most significant/least significant byte pairs; therefore this
section of the data will be 16 x 3 x 2 = 96 bytes.
o 16 bytes of pre or post arbitrary MIDI data. This data can contain any
MIDI data. Unused data elements contain 0xFF. Again it is transmitted
as msn/lsn byte pairs; therefore this section of data will be 16 x 2 = 32
bytes.
o Three bytes of configuration data (see below) 3 x 2 = 6 bytes.
A total received packet then includes all of the above plus the system exclusive
packet header and EOX byte. A total received preset is 153 bytes.

Command:
(hex)

F0
7D
22
23
<pre>
F7

System Exclusive
Manufacturer ID. User settable – default is 7D.
Device ID for the MIDI Patch Changer.
Command type.
Preset # 0x00 to 0x7F (0 to 127 decimal).
End of System Exclusive

Example: Read Preset #100’s data.
Transmitted:
(hex)

Received:
(hex)
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F0
7D
22
23
63
F7

System Exclusive
Manufacturer ID. User settable – default is 7D.
Device ID for the MIDI Patch Changer.
Command type.
Preset # (0x00 to 0x7F)
End of System Exclusive

F0
7D
22

System Exclusive
Manufacturer ID. User settable – default is 7D.
Device ID for the MIDI Patch Changer.
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24
63
<
:
>
<
:
:
:
>
<
:
:
:
>
00
P/P LSN
00
00
00
00
F7
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Command type (ready for re-transmission).
Preset number.
13 bytes of ASCII data for the Preset Name

16 sets of (3 bytes x 16 MIDI channels)
Bank Select MSB/Bank Select LSB/Patch Change
bytes sent as msn/lsn byte pairs. 96 bytes total

16 byte pairs of arbitrary MIDI data.

Pre/Post flag most significant nibble (always 0)
Pre/Post Arb MIDI data flag least significant nibble
(00 = Pre, 01 = Post)
Reserved
Reserved
Reserved
Reserved
End of System Exclusive
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Set One Preset Command (old format)
The Set Preset Sys Ex command allows you to write one preset to the MIDI
Patch Changer keypad. This command is variable length in that you don’t need
to send the entire 153 bytes. You can just send what you want and terminate
with an EOX byte. The remainder of the preset you are modifying will be
“disabled” (all values set to 0xFF). Therefore you can set the name and only a
couple of patch change sets if that is all you need.

A Preset consists of the following data:
o 13 character ASCII name. Use space characters to pad if necessary.
o Up to 16 MIDI channels worth of Bank MSB/Bank LSB/Patch Change.
The values for these bytes are 0x00 to 0x7F regardless of user
preferences. Disabled (unused) values should be 0xFF. These values
are transmitted as most significant/least significant byte pairs; therefore
this section of the data will be up to 16 x 3 x 2 = 96 bytes.
o Up to 19 bytes of (optional) arbitrary MIDI data. This data can contain any
MIDI data. Unused data elements should contain 0xFF.
Again it is
transmitted at msn/lsn byte pairs; therefore this section of data will be up
to 19 x 2 = 38 bytes.

Transmitted:
(hex)

MTG

F0
7D
22
24
<pre>
<
:
>
<
:
:
:
>
<
:
:
:
>

System Exclusive
Manufacturer ID. User settable – default is 7D.
Device ID for the MIDI Patch Changer.
Command type.
Preset # 0x00 to 0x7F (0 to 127 decimal).
13 bytes of ASCII data for the Preset Name

Up to 16 sets of (3 bytes x 16 MIDI channels)
Bank Select MSB/Bank Select LSB/Patch Change
bytes sent as msn/lsn byte pairs. 96 bytes max.

16 byte pairs of arbitrary MIDI data
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00
P/P LSN
00
00
00
00
F7

Pre/Post byte most significant nibble (always 0)
Pre/Post byte least sig nibble
(00 = Pre, 01 = Post)
Reserved
Reserved
Reserved
Reserved
End of System Exclusive

Received: ACK packet

Example:

In the data captured above you can see the following elements (in order):
o The green portion represents the Sys Ex header [F0 … 00].
o The blue portion represents the ASCII patch name [41 … 20].
o The white portion represents the MSB/LSB/Pgm Chg data (16 of).
Remember that the bytes are split into MSN/LSN pairs.
o The yellow portion represents the arbitrary MIDI data section. In this case
we have the following MIDI data (again in MSN/LSN pairs):
o 09 01 03 04 07 0F = 91 34 7F (note on)
o 08 01 03 04 07 0F = 81 34 7F (note off for above)
o 09 02 03 04 07 0F = 92 34 7F (note on, different channel)
o 08 02 03 04 07 0F = 82 34 7F (note off for above)
o 00 01 00 02 03 00 04 00 05 00 05 00 06 (sample MIDI gibberish)
o The red F7 is the End-of-Exclusive.

MTG
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Get One Preset Command (NEW format)
By sending a Get Preset Sys Ex command from a host device, the user can
query and save the settings for a single Preset. A Preset consists of the
following data:
o 13 character ASCII name.
o Pre-Patch MIDI data Delay value. 0x00 to 0x7F (0ms to 127ms per byte
sent).
o Patch Change data Delay value. 0x00 to 0x7F (0ms to 127ms per byte
sent).
o Post-Patch MIDI data Delay value. 0x00 to 0x7F (0ms to 127ms per byte
sent).
o 16 MIDI channels worth of Bank MSB/Bank LSB/Patch Change. The
values for these bytes are 0x00 to 0x7F. Disabled (unused) values will be
0x80 or 0xFF. These values are transmitted as most significant/least
significant byte pairs (nibbles); therefore this section of the data will be 16
x 3 x 2 = 96 bytes.
o One byte of Pre-Patch data length (0x00 to 0x5A). This indicates the
length of Pre-Patch MIDI data to follow from 0 to 90 bytes.
o Optional up to 90 bytes of Pre-Patch MIDI data sent as most
significant/least significant byte pairs (nibbles).
o One byte of Post-Patch data length (0x00 to 0x5A). This indicates the
length of Post-Patch MIDI data to follow from 0 to 90 bytes.
o Optional up to 90 bytes of Post-Patch MIDI data sent as most
significant/least significant byte pairs (nibbles).
A total received packet then includes all of the above plus the system exclusive
packet header and EOX byte.
Command:
(hex)

F0
7D
22
30
<pre_msn>
<pre_lsn>
F7

System Exclusive
Manufacturer ID. User settable – default is 7D.
Device ID for the MIDI Patch Changer.
Command type.
Preset # 0x00 to 0xC7 (0 to 199 decimal) msn.
Preset # lsn (least significant nibble).
End of System Exclusive

Example: Read Preset #100’s data.
Transmitted:
(hex)

MTG

F0
7D
22
30

System Exclusive
Manufacturer ID. User settable – default is 7D.
Device ID for the MIDI Patch Changer.
Command type.
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Received:
(hex)

MTG

06
03
F7

Most significant nibble of the value 63.
Least significant nibble of the value 63.
End of System Exclusive

F0
7D
22
31
06
03
<
:
>
dd
dd
dd
<
:
:
:
>
LL
<
:
:
>
LL
<
:
:
>
F7

System Exclusive
Manufacturer ID. User settable – default is 7D.
Device ID for the MIDI Patch Changer.
Command type (ready for re-transmission).
Preset number msn.
Preset number lsn,
13 bytes of ASCII data for the Preset Name
One byte of Pre-Patch delay (in ms)
One byte of Patch-Change delay (in ms)
One byte of Post-Patch delay (in ms)
16 sets of (3 bytes x 16 MIDI channels)
Bank Select MSB/Bank Select LSB/Patch Change
bytes sent as msn/lsn byte pairs. 96 bytes total
One byte of Pre-Patch length data (0x00 - 0x5A).
Zero to 90 msn/lsn byte pairs of Pre-Patch
arbitrary MIDI data.
One byte of Post-Patch length data (0x00 - 0x5A).
Zero to 90 msn/lsn byte pairs of Post-Patch
arbitrary MIDI data.
End of System Exclusive
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Set One Preset Command (NEW format)
The Set Preset Sys Ex command allows you to write one preset to the MIDI
Patch Changer keypad. This command is variable length and depends on the
size if Pre-and Post- Patch arbitrary MIDI data contained within.
A Preset consists of the following data:
o 13 character ASCII name.
o Pre-Patch MIDI data Delay value. 0x00 to 0x7F (0ms to 127ms per byte
sent).
o Patch Change data Delay value. 0x00 to 0x7F (0ms to 127ms per byte
sent).
o Post-Patch MIDI data Delay value. 0x00 to 0x7F (0ms to 127ms per byte
sent).
o 16 MIDI channels worth of Bank MSB/Bank LSB/Patch Change. The
values for these bytes are 0x00 to 0x7F. Disabled (unused) values will be
0x80 or 0xFF. These values are transmitted as most significant/least
significant byte pairs (nibbles); therefore this section of the data will be 16
x 3 x 2 = 96 bytes.
o One byte of Pre-Patch data length (0x00 to 0x5A). This indicates the
length of Pre-Patch MIDI data to follow from 0 to 90 bytes.
o Optional up to 90 bytes of Pre-Patch MIDI data sent as most
significant/least significant byte pairs (nibbles).
o One byte of Post-Patch data length (0x00 to 0x5A). This indicates the
length of Post-Patch MIDI data to follow from 0 to 90 bytes.
o Optional up to 90 bytes of Post-Patch MIDI data sent as most
significant/least significant byte pairs (nibbles).
Including the Sys Ex header and EOX byte, the command size varies from 168
bytes (both arb MIDI data sections have only the 00 length byte) to 528 bytes
(both arb MIDI data sections contain the length byte and 90 byte pairs each).

Transmitted:
(hex)

MTG

F0
7D
22
31
pp_msn
pp_lsn
<
:
>
dd

System Exclusive
Manufacturer ID. User settable – default is 7D.
Device ID for the MIDI Patch Changer.
Command type.
Preset number (most significant nibble).
Preset number (least significant nibble).
13 bytes of ASCII data for the Preset Name
One byte of Pre-Patch delay (in ms)
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dd
dd
<
:
:
:
>
LL
<
:
:
>
LL
<
:
:
>
F7

Received:

One byte of Patch-Change delay (in ms)
One byte of Post-Patch delay (in ms)
16 sets of (3 bytes x 16 MIDI channels)
Bank Select MSB/Bank Select LSB/Patch Change
bytes sent as msn/lsn byte pairs. 96 bytes total
One byte of Pre-Patch length data (0x00 - 0x5A).
Zero to 90 msn/lsn byte pairs of Pre-Patch
arbitrary MIDI data.
One byte of Post-Patch length data (0x00 - 0x5A).
Zero to 90 msn/lsn byte pairs of Post-Patch
arbitrary MIDI data.
End of System Exclusive

ACK packet
F0 7D 22 31 06 03 41 F7

MTG
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Get One Chain Command
By sending a Get One Chain Sys Ex command from a host device, the user can
query and save the settings for a single Chain. A Chain consists of the following
data:
o 13 character ASCII name
o 18 Links of Chain data (18 Preset numbers). Valid Preset numbers are in
the range of 0 to 199 (decimal). Higher values, such as 255 are
considered “empty” chain links. The first empty chain link indicates end-of
chain to the keypad at run time. These preset links are transmitted over
sys ex in msn/lsn byte pairs.
o Two bytes of reserved configuration data (both 0).
A total received packet then includes all of the above plus the system exclusive
packet header and EOX byte. A total received chain is 58 bytes.

Command:
(hex)

Received:
(hex)

MTG

F0
7D
22
32
ch_msn
ch_lsn
F7

System Exclusive
Manufacturer ID. User settable – default is 7D.
Device ID for the MIDI Patch Changer.
Command type.
Chain # msn
Chain # lsn
End of System Exclusive

F0
7D
22
32
ch_msn
ch_lsn
<
:
>
<
:
>
00
00
F7

System Exclusive
Manufacturer ID. User settable – default is 7D.
Device ID for the MIDI Patch Changer.
Command type.
Chain # msn
Chain # lsn
13 bytes of ASCII data for the Chain Name

Eighteen Preset “links” in msn/lsn byte pairs.
Reserved
Reserved
End of System Exclusive
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Example: Read Chain #1’s data. Assume the links in the chain are
Chain Link
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18

Preset #
001
002
003
004
005
005
007
008
009
011
012
013
014
015
016
017
018
200

and that there is no arbitrary MIDI data (both length bytes are set to 0).
Transmitted:
(hex)

F0
7D
22
30
06
03
F7

System Exclusive
Manufacturer ID. User settable – default is 7D.
Device ID for the MIDI Patch Changer.
Command type.
Most significant nibble of the value 63.
Least significant nibble of the value 63.
End of System Exclusive

Received:

MTG
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Set One Chain Command
The Set One Chain Sys Ex command allows you to write one Chain to the
keypad. A Chain consists of the following data:
o 13 character ASCII name
o Up to 18 Links of Chain data (18 Preset numbers). Valid Preset numbers
are in the range of 0 to 199 (decimal). Higher values, such as 255 are
considered “empty” chain links. The first empty chain link indicates end-of
chain to the keypad at run time. These preset links are transmitted over
sys ex in msn/lsn byte pairs.
o Two bytes of reserved configuration data (both 0).
You can send a smaller command. That is, you can just send what you want and
terminate with an EOX byte. The remainder of the chain you are modifying will
be “disabled” (all links set to 0xFF). Therefore you can set the name and only a
couple of links if that is all you need.
Command:
(hex)

Received:

F0
7D
22
33
ch_msn
ch_lsn
<
:
>
<
:
>
00
00
F7

System Exclusive
Manufacturer ID. User settable – default is 7D.
Device ID for the MIDI Patch Changer.
Command type.
Chain # msn
Chain # lsn
13 bytes of ASCII data for the Chain Name

Eighteen Preset “links” in msn/lsn byte pairs.
Reserved
Reserved
End of System Exclusive

ACK packet
F0 7D 22 33 06 03 41 F7

MTG

- 59 -

MPC Keypad v4.00

Universal Device Inquiry
In response to the Universal Device Inquiry command (F0 7E 7F 06 01 F7), the
keypad responds with a 16-character ASCII string indicating the product name
and version. For example, “MIDIPatch v3.10”.

MTG
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Appendix B: Sys Ex Firmware Update via MIDIOX
You can “reflash” the firmware in the MIDI Patch Changer using the supplied PC
editor or by carefully following the procedure outlined in this section. Obtain the
latest firmware in .SYX format from the website. Again we show the process
using MIDIOX, but you should be able to use any similar program (and of course
the editor/librarian on a Windows PC).

Configure MIDIOX
The configuration is the same as described in the Download Preset section of
this manual. It is repeated here for convenience. Set the Sys Ex properties of
MIDIOX by clicking:
View -> SysEx…

then

SysEx->Configure .

Use the recommended setting shown in the above Configure panel.

MTG
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Prepare the Keypad for Download
You must use the 5-pin DIN cable/box for firmware upgrades. You cannot
upgrade using the provided MiniTerm USB cable. The firmware upgrade will
not affect your stored presets (unless the firmware upgrade is designed to add
new features that make the old preset data invalid).
There are two ways to set the keypad in a mode that accepts new firmware.
3. The first method is using the UTIL menu. Press the UTIL button and then
press the down arrow key repeatedly until you see the menu item:

Press ENTER and when prompted to confirm (ENTER to upgrade), then
press ENTER again. At this point the MIDI Patch Changer passes control to
the internal MIDI Loader.
MidiLoader v2.00
4. The other method can be used even in the unlikely event that you “brick” the
firmware (cause the device to malfunction due to improper reprogramming).
In this case unplug the keypad. Press and hold down CLEAR and ENTER.
With these two keys down, plug in the powered 5-pin DIN cable/box. Once
power has been applied through the box to the keypad, release the keys. You
should see:
MidiLoader v2.00

Test the Communication
If you send a Universal Device Inquiry system exclusive packet to the keypad, it
will respond with the MidiLoader version packet. In MIDIOX, click:
View -> SysEx…
Then from the SysEx menu click
Command Window -> Load File…

MTG
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Choose the file Universal Device Inquiry.syx and click open. Click
Command Window -> Send/Receive Sysex
The keypad will respond with 24 bytes. Click on Done. Next click on
Display Window -> Hex View Swap
You may have to enlarge the window a little, but you should see something like
this:

Now you can proceed with the firmware upgrade.

Firmware Upgrade
Close the SysEx View window and open it again to get an empty window. If you
are prompted to save anything, click No.
Open the new firmware file by clicking
Command Window -> Load File…

MTG
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Choose the file required for the upgrade (E.g. MidiPatch_v1_00.syx). You
should see that a fairly large file is opened.

Click on
Command Window -> Send/Receive Sysex
The upgrade takes approximately 30 seconds. Do not touch the computer or
keypad during this time. At the end of the upgrade the keypad will reboot. Also
the MIDIOX screen will show a fairly large number of transactions.

You can close MIDIOX (don’t save anything) and begin using the updated
keypad.
MTG
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